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License and Warranty 

 

This document and code was written for the Mimetics Jade RobotTM and follow on products.    

 

This document and code is considered Mimetics Proprietary and may not be released outside of Mimetics except 

by permission of Mimetics, Inc.   

 

Software Compatibility 
 

The script language described in this document was written to be supported by: 

Jade Support 0.9.9.24 or later 

Robot Software Release 42 or later 

Robot Tokenizer Version 0.11.17 or later 

XML Processor 0.1.5 or later 

_start.s defined as _main_10.script or later 

 

Conventions, Options and Selections 
 

Example code will be put in monospace font like: 

 
    A = B + C 

 

In the language definition, there are a number of instances where there are optional parameters or multiple 

parameters for the same task.  To make these situations more obvious, the following convention is used: 

 

[] – Optional parameter  

| - One parameter or another 

... – Previous parameter can be repeated 

<none> - indicates that nothing is a possible option 
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Welcome 
 
When we started working on the Jade RobotTM we had a vision for it to be easy to use anywhere and 
provide users with a platform that would provide more sophisticated capabilities as the user’s abilities 
grew.  A corner piece of this is the built in OLED based user interface which provides access into the 
robot as well as a way to program and command its operation.  From the programming perspective, we 
have created an easy to use Integrated Development Environment (IDE) that provides the ability to 
create and learn starting with “Scratch” programming and moving on to the “C” language.  Finally, we 
knew the robot had to be expandable, having the ability to add features and capabilities for specific 
missions and experiments.  We’re very pleased with the final product and think it has accomplished the 
requirements set out for it and we are proud to present it to you.   
 
Like many products which strive to be simple and easy to use, Jade Robot probably appears very 
complex – a diagram of the robot outlining all its features probably is overwhelming: 

 
This document, will present the different features of the Jade Robot as well as an introduction to 
connecting the Jade Robot to a PC via Bluetooth and using the Jade Support IDE.   
 
As good as the Jade Robot is, it’s not perfect.  Mimetics was founded on a philosophy of constant 
improvement and this is designed in to the Jade Robot with the ability to update its software.  To 
improve the Jade Robot, we need your feedback and comments.   
 
Please contact us via email at: 
info@mimetics.ca 
 
Thank you for your interest and we look forward to hearing from you and making the Jade Robot even 
better!  
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Out of the Box 
 
Hopefully you have noticed that the packaging the Jade Robot is saved in is rugged and has a handle; its 
purpose is to be used to store and transport the Jade Robot – Please Don’t Throw The Box Away! 
 
The important features of the Jade Robot that you will need to be familiar with  can be seen in this 
image: 

 
 

Power 
 
The Jade Robot has a built in 2200mAh Lithium Polymer battery.  This will provide seven hours of 
operation in a typical setting.  When the Jade Robot is not being used, it will go into a low power “Sleep 
Mode” which it is awakened from by pressing the “Down” white navigation button.  When the robot is 
in Sleep Mode, it will flash one of the six green LEDs on the top of the robot once every five seconds.  If 
the green LEDs are not flashing, then the Jade Robot’s battery requires recharging.   
 

Charging the Jade Robot 
 
Inside the box, you’ll find the Jade Robot along with an AC/DC USB power adapter and a USB “A” to 
“micro” cable.  The USB Power Adapter and cable is used for charging the Jade Robot.  To charge the 
Jade Robot, plug the AC/DC USB power adapter into a 110V AC socket with the USB cable plugged in to 
the USB socket at the top and the cable plugged into the USB/Charging connector indicated in the image 
above.   
 
During charging a green and blue LED located on the bottom of the Jade Robot will turn on.  When the 
Jade Robot is fully charged, the blue LED will turn off and another green LED will turn on.  It takes five 
hours or so to charge the robot.   

Bluetooth Indicator LED

Red “Enter” Button

White Navigation Buttons

Front of Jade Robot

USB/Charging
Connector

Blue Reset
Button

OLED Display
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The Reset Button 
 
While there is a reset button on the Jade Robot, it should not be required for normal usage.  Later 
versions of the Jade Robot will either not have a reset button or have it in a location where it cannot be 
easily accessed.   
NOTE: The reset button should never be used as a “fast disconnect” of the Jade Robot Bluetooth 
connection to a PC or Mac.  This will cause problems with the PC link software resulting in the possible 
need for removing and then repairing the Jade Robot and/or restarting the PC or Mac.   
 
If there is a situation where the use of the reset button is required (this includes “Run Time Errors” 
mentioned below), please contact Mimetics as noted above to report the circumstances.   
 

The File System 
 
One feature that truly sets the Jade Robot apart from other educational robots is the inclusion of a file 
system which is used to store applications, “panel” files (which provide simplified user interface menus”, 
function files, bitmap images, wav sound files and text files.  These files can be updated at any time in 
terms of deleting or storing new files in the system (“renaming” a file would consist of reading the 
contents of the file, deleting it and then storing the contents under a new name).  The File System does 
not have any provisions for folders which means that users must strive to avoid applications which have 
files that are of the same name as existing files in the robot (basic system files cannot be accessed which 
prevents them from being inadvertently overwritten).   
 
The File System used in the Jade Robot is known as a “Journaling File System”.  This means that when a 
file is deleted, the space it is used is marked as “deleted” and ignored.  Obviously there will be a point 
when all the file memory is used up and, at this point, there needs to be a “garbage collection” 
operation which overwrites the “deleted” areas of the file system.  It is possible to explicitly command 
garbage collection from the Jade Robot’s user interface.   
 

Run Time Errors 
 
There will be cases when the Jade Robot stops with a flash of the six topside green LEDs.  Along with 
that will be failure information displayed on a box overlaying the current display on the Jade Robot.  
These errors are known as “Run Time Errors” and provide the user with information regarding the 
operation of the Jade Robot.  There should not be any Run Time Errors with the software that comes 
with the Jade Robot – but ... software is never perfect.  If an error is displayed, like on the screen shot 
below, please report it as outlined above.   
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Navigating the User Interface 
 
The User Interface built into the Jade Robot allows you to select different example applications, perform 
on board programming of the Jade Robot or change different operating parameters of the robot.  When 
the user interface first comes up, it will show you the “Main Menu” that’s described in the image below: 

 
Navigation is accomplished using the white navigation buttons identified on the previous page.  When 
the desired control is highlighted (has a box around it), it can be activated by pressing the red “Enter” 
button.  In some cases, the white navigation buttons provide control activation.  To return from an 
application, the convention currently used is to navigate to the bottom left hand corner where there is a 
“Return” Control and then press the Enter button to return to the previous menu.   
 
A demonstration of the operation of the navigation buttons is given on the Mimetics web page: 
http://www.mimetics.ca   
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On Board
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http://www.mimetics.ca/
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User Interface “Main Menu” 
 
The Main Menu is the initial interface for accessing applications on the Jade Robot.  The primary 
purpose of the Main Menu is to provide a list of applications that the user is most likely to work on – 
although it should be noted that different applications can be added or deleted as required.  It’s 
presented here so that the basic formatting can be shown: 

 
The different parts of the Main Menu are: 
 
Currently Selected Application Descriptor: Applications can have a short (13 character) message 
displayed on the OLED when the application is highlighted (this is only possible for Jade C applications 
and is described in the Jade C .  If a message is not specified, then the execution file name is listed.   
 
Bluetooth Status Indicator: Indicate if power is being supplied to the Jade Robot’s Bluetooth adapter 
and whether or not the Jade Robot is connected to a PC or Mac. 
 
Battery Charge Indicator: Present the amount of charge present in the Jade Robot’s battery. 
 
“Tools Menu” Control: Navigate to this control and press the Enter button to go to the Tools Menu. 
 
“Return” Control: shown in the Main Menu to indicate its position.  Note that it is blocked off and the 
user cannot navigate to it in the Main Menu.   
 
The operation of the different default applications are discussed later in this document.   
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User Interface “Tools Menu” 
 
The Tools Menu is the system interface for the Jade Robot.  The format of the Tools Menu follows the 
convention used for the Main Menu, but there are no applications and the Tools options cannot be 
changed or modified.  The different options are described in detail after the screen image below: 

 
Bluetooth Enable: To maximize battery life, the Bluetooth adapter built in the Jade Robot can be turned 
on and off with the reset default being turned off.  Bluetooth can be turned on using the Bluetooth 
Enable Menu and selecting the “Bluetooth On” control.  The MAC Address is just used by Mimetics.   

 
 
 

Tools Menu

Unavailable
“Tools Menu”
Control

“Bluetooth Enable”

“Return”
Control

“Friendly Name”

“Volume”

“Remote Type”

“Registered
Marks & 
Version
Information”“Sleep Timeout” “Files”

“Calibration”

Bluetooth Menu

Bluetooth 
Control Icon

Bluetooth MAC Address

“Return”
Control

Bluetooth On

Bluetooth Off

NOTE: Bluetooth MAC Address is used by Mimetics as a Serial Number
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Friendly Name: While the user is not concerned with the Bluetooth MAC Address, the Bluetooth 
“Friendly Name” provides a way of uniquely identifying the Jade Robot.  This is particularly important in 
situations where multiple Jade Robots are in use and being paired with PCs in a classroom setting.  The 
menu acts as a simple line editor, allowing the change of the default Bluetooth Friendly Name (which is 
“Jade Robot”) to something different.  To save the new name, the user must exit from the menu using 
the “Return” control.  NOTE: the Friendly Name cannot be changed while the Jade Robot is connected to 
a PC or Mac.   

 
Remote Type: The operation of the Jade Robot’s Navigation and Enter buttons can be emulated with a 
DVD remote control.  The three manufacturer’s devices currently supported can be changed, allowing 
multiple Jade Robots to work/compete in the same area. 

 

Bluetooth Friendly Name Menu

Bluetooth
Friendly Name 
Control Icon

Bluetooth Friendly Name

“Return”
Control

Keypad

Backspace

Space

Capslock

Remote Control Type Select Menu

Remote Control
Select Icon

Different Device Manufacturers

“Return”
Control

NOTE: DVD Remotes ONLY to Ensure they have the Navigation Buttons
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Volume: The volume of the Jade Robot’s speaker can be raised or lowered to the point where it is 
muted. 

 
Sleep Timeout: Sleep Mode can automatically be invoked after a set period of time if the Jade Robot’s 
Navigation buttons are not being pressed, the Jade Robot is not connected to a PC and if the Main Menu 
or a Tools Menu is active (the Jade Robot will not go into Sleep Mode if an application is executing).  The 
default time is two minutes and can be as high as 99 minutes.  Sleep Mode can also be disabled all 
together.  When connecting a Jade Robot to a PC, it is recommended that the Sleep timeout is set to 15 
minutes.   
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Files: As noted above, the Jade Robot has a file system built into it.  At the time of this document’s 
writing, there are 245 different files loaded into the system (consisting of executable, panel, image, 
sound and text files).  The File Menu provides the ability to list the applications stored in the File System, 
execute them, delete them as well as bring them onto the Main Menu.  It should also be noted that the 
user can perform a garbage collection operation on the Jade Robot. 

 
Calibration: The current Jade Robot is built with DC motors which can vary from motor to motor.  To 
counteract that, the Calibration Menu can be used to validate the speed of each motor to provide 
straight lines and expected operating distances.  The new Calibration values are saved when the user 
exists the Menu (through the “Return” control).   

 

File Menu

File Control 
Icon

Application File Name

“Return”
Control

Decrease Position

Delete 
Application

Garbage Collect

Free Space in File System

Increase Position

Current Main 
Menu Position

Scroll Up
Scroll Down

Calibration Menu

Calibration
Icon

Decrease Turn Duration

“Return”
Control

Adjust Left

Turn 360

Adjust Right

Run Forwards

Increase Turn Duration
Turn Duration Indicator

Adjust Indicator
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Registered Marks and Version Information: This menu provides the user with a list of registered marks 
in relation to the Jade Robot as well as version information for the hardware and software.   

 

 

  

About Jade Robot Menu

About Jade 
Robot Icon

“Return”
Control
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“Main Menu” Default Applications 
 
The Jade Robot is shipped with a number of default applications which are available for execution on the 
Main Menu.  As noted before, the position of the applications as well as which ones that are available on 
the Main Menu can be changed using the “File Menu” described above.   
 
Spectrometer: The Jade Robot’s spectrometer uses six LEDs on the bottom of the robot to create a 
signature of the material the Jade Robot is currently over.  The reflected energy is measured and 
presented as a percentage on the Jade Robot’s display.  Pressing the red “Enter” button ends the 
application.   

 
 
The LEDs that are used with the spectrometer are: 
Blue – 470nm wavelength 
Green – 525nm wavelength 

Yellow – 574nm wavelength 
Red – 660nm wavelength 

880nm wavelength Infrared 
940nm wavelength Infrared 

 

Spectrometer Application

Spectrometer
Icon

Spectrometer Reading

“Return”
Control
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Remote Move: How the tracked differential drive of the Jade Robot works is shown in this application.  
By pressing the “Up” white navigation button, the Jade Robot will move forwards, pressing the “left” 
white navigation button causes the Jade Robot to turn to the left (as shown in the screenshot below) 
and so on.  This application was originally developed for demonstrating how an IR remote control could 
be used to send commands to the Jade robot, but it is an excellent application for showing how the 
robot moves.  Pressing the red “Enter” button ends the application.   

 
 
  

Remote Move Application
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Moth: Grey Walter, of the Burden Neurological Institute, is normally credited with creating the first 
electronic autonomous robots. His robots “Elmer” and “Elsie”, were simple light seeking robots which 
behave like moths – they would be attracted to a light and then, when the light got too bright, they 
would shy away, making a seemingly random pattern about the light.  The moth application replicates 
this behaviour.  Pressing the red “Enter” button ends the application.   

 
 
  

Moth Application
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Line Follow: A very traditional application for robots is the line follower.  For this application, the best 
results seem to be with a strip of black electrical put down on a light surface.  This application can be 
easily fooled – it is available in Jade Robot’s community projects on GitHub and can be very easily copied 
and experimented with.  Pressing the red “Enter” button ends the application.   

 
  

Line Follow Application

Line Follow
Icon

Line Sensor Values

“Return”
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Object Avoid: This simple application monitors the two front object sensors and when an object gets 
too close (less than the value 30 returned from the object sensors) it turns away.  Pressing the red 
“Enter” button ends the application.   

 
 
  

Object Avoidance Application

Object Avoid
Icon

Object Sensor Indicators

“Return”
Control
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Program Demo: This application is generally the first introduction to Jade Robot Programming.  By 
navigating to the arrows and then selecting them, a simple movement program can be created.  When 
the program is ready, the “Program Start Control” is selected and the robot will move through the 
program.  A spectrometer reading can be specified to take place at the end of the program – simulating 
a robot on another planet which is to move to a specific location and then take a spectrometer reading.  
Pressing the red “Enter” button ends the application.   

 
BONUS: If there are multiple Jade Robots available, program all of them with the same program, set 
them in a line and start the programs all at the same time.  This is what is typically called the “Jade 
Robot Line Dance”! 
  

Program Demo Application

Program Demo
Icon

Movement Selection Arrows

“Return”
Control

Program Start Control

Spectrometer SpecificationProgram to Execute
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Wall Follow: The wall follow application does just that, it will follow a wall to its right side.  The 
application was originally developed to demonstrate a simple algorithm for navigating a maze – if a 
person keeps one hand on a wall of the maze at all times, they will eventually reach the end of the 
maze.  Pressing the red “Enter” button ends the application.   

 
 
  

Wall Follow Application

Wall Follow
Icon

Object Sensor Indicators

“Return”
Control
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Logic: The final built in application allows the user to create a surprisingly complex program on the Jade 
Robot.  The program normally runs forwards, but will continually poll sensors as set out in “Sensor Type 
Selection” (changing from “X” or nothing to “Object Detect”, “Light Sensor” and “Line Sensor”) and then 
specifying which sensor is to be used, the value to compare against (and how to compare against it, less 
than or greater than) and what to do (different motions are available).  The higher the comparison is in 
the list of four, the higher priority it is given.   

 
The program that is executed can be illustrated as: 
Each specified condition is checked and if it is true, then the Jade 
Robot performs the specified action.  If none of the specified 
conditions are true, the Jade Robot simply moves forwards.  
Surprisingly complex applications can be created using this 
application.   
 
Just as a note, in the sample screen showing the “Logic” application, 
there is an error.  It is a simple object avoidance program, but when 
an object to the right is detected, the “True” operation it to turn 
right and the opposite is true for the left sensor.  In a true object 
avoidance program, the robot would turn away from any sensed 
objects, not towards them.   
 
If this was the case in an executing robot, the user would simply 
stop the program’s execution, navigate to the two movement 
commands and change them.   
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Programming the Jade Robot 
 
The previous sections describe how to use and program the Jade Robot using it’s built in user interface.  
The Jade Robot can also be controlled and programmed through its Bluetooth and USB interfaces.   
 
The primary programming interface is known as “Jade Support” and provides users with the ability to 
manage projects, download them into the Jade Robot and debug them.   

 
 
Jade Support is a Google Chrome App and will work on Windows (XP, Vista, 7 * 8) or Mac (“Mavericks” 
or later) system that has the latest version of Chrome and has a Bluetooth Interface.  It can be installed 
from here: https://chrome.google.com/webstore/detail/jade-
support/gchcbahadlpkgkpenlkfgdgkdjedepod  
 
For more information regarding using Jade Support, go to the introductory document.   

  

https://chrome.google.com/webstore/detail/jade-support/gchcbahadlpkgkpenlkfgdgkdjedepod
https://chrome.google.com/webstore/detail/jade-support/gchcbahadlpkgkpenlkfgdgkdjedepod
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Bluetooth Connections 

 
Detailing how to pair the Jade Robot and connect to Jade Support for the various versions of Windows 
and Mac OS X would require 20+ pages, so for efficiency, the Mimetics web page has this information 
tabbed so that the user can work through their specific operating system.  The basic process for 
connecting the Jade Robot to Jade Support is: 
 

1. Bring the Jade Robot out of Sleep Mode (press and hold the Down Navigation Button).   
2. Navigate to Tools  Bluetooth and turn on the Jade Robot’s built in Bluetooth adapter (the blue 

LED by the Bluetooth adapter will start flashing). 
3. Navigate to Tools  Friendly Name and give the Jade Robot a unique name.   
4. Navigate to Tools  Timeout and specify a 15 minute timeout for the Jade Robot. 
5. On the PC or Mac, start the Bluetooth utility, ensure the system’s Bluetooth Adapter is on and 

start searching.   
6. When the “Friendly Name” for the Jade Robot appears, select it and pair it with the system.  If 

asked for a PIN code, enter “1234”.   
7. On PC systems, when the pairing is complete, record the “com” port number.   
8. Go to the Chrome Web Store and using the link 

(https://chrome.google.com/webstore/detail/jade-
support/gchcbahadlpkgkpenlkfgdgkdjedepod) install and launch Jade Support.   

9. Either use an existing GitHub account or create a new one and allow Jade Support to access it.   
10. Connect to the Jade Robot using the Windows “com” port on the Friendly Name on a Mac.   

 
Everything is ready for programming the Jade Robot.  Please see the “Jade Support Introduction” 
document for directions on how to use community projects as well as create new ones.   
 
 

  

https://chrome.google.com/webstore/detail/jade-support/gchcbahadlpkgkpenlkfgdgkdjedepod
https://chrome.google.com/webstore/detail/jade-support/gchcbahadlpkgkpenlkfgdgkdjedepod
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Expanding the Jade Robot 
 
The Jade Robot has been designed for user expansion.  Probably the most popular expansion option is to 
add a gripper and camera to the Jade Robot.  Plans for a 3D printed version of the gripper will be 
available shortly.   

 
The dimensions of the Jade Robot from the front are: 

 
Additional information and documentation will be available in the near future. 
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Supporting Documents 
 

Currently None 

 

Glossary 
 

ASCII – Standard 8 bit character set.  See http://en.wikipedia.org/wiki/ASCII 

 

 

http://en.wikipedia.org/wiki/ASCII
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